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What’s New in ProTA 4.3 
ProTA 4.3 is an exciting feature-level upgrade, free for all users!  


The ProTA market analysis platform now consists of a powerful macOS-based desktop 
application as well as companion mobile apps for iPhone and iPad. 


•	 ProTA for macOS desktop continues to be your primary workstation and 
authoring tool.  


	 

	 You can always download the latest, free macOS desktop application at https://

www.beesoft.net 


•	 ProTA Mobile for iOS is a companion to your ProTA desktop software.  


	 Please visit the Apple App Store on your Apple mobile devices to download the free 
companion ProTA Mobile apps for iPhone and iPad.  Search “ProTA Mobile”.


Your existing Activation Code unlocks all features on all your devices. 


 New Features	  
In addition to many minor interface updates, bug fixes and MacOS Big Sur updates, the 
4.3 update is highlighted by the following new features:


•	 Companion iOS app for iPhone and iPad with syncing via iCloud

•	 Support for Dark Mode under 10.14 (Mojave) and higher.

•	 Added new Standard Indicator Auto Linear Regression Trendlines.

•	 Added ProTAscript function AutoLRTrendline().

•	 Added new Standard Indicator Auto Retracements.

•	 Added ProTAscript function AutoSupportResistance().

•	 Added Heikin-Ashi charting.

•	 Added ProTAscript function HeikinAshi().

•	 Added Close-Based Coloring option to Candlesticks.

•	 Added ProTAscript function Correlation().

•	 Added ProTAscript function Median().


https://www.beesoft.net
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•	 Added ProTAscript functions NumBars() and BarNum().

•	 Added ProTAscript pragmas !Line and !RangeFill to specify plotted formatting directly 

in code.

•	 Added Forward/Previous Chart commands.

•	 Added Preference to display Weekly & Monthly Volumes as Totals vs. Averages.

•	 Save file sheets now include a Save Location popup menu.

•	 Copy Entire Chart command now copies all plotted indicators in the chart to a text 

table for pasting into external spreadsheets.

•	 Added reminder alert when Activation is near expiration date.

•	 NYSE Holidays updated through 2021.

•	 ProTAscript interpreter now recognizes curly quotation marks in addition to the 

straight ASCII.

•	 Added 50+ new custom indicators, trading systems, smartlists and templates to the 

default installation.


To help illustrate some of these features, ProTA 4.3 installs a number of new files into 
your database into folders named “4.3 Additions”.  


Additionally, 6 new folders filled with new Custom Indicators have been added. You are 
free to move, rename or delete any of the new files.


In the Help menu, The ProTA User Manual has been updated to provide detailed 
assistance.  Additionally, an all new ProTA Mobile User Manual is included.


A more complete Version History can be viewed at https://www.beesoft.net/prota-
version-history.html


The remainder of this document is an overview of some of the major new 4.3 features, 
with page references to the updated ProTA User Manual.
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 Syncing macOS to iOS via iCloud - page 251	  
The ProTA market analysis platform now consists of a powerful macOS-based desktop 
application as well as companion mobile apps for iPhone and iPad. 


Use ProTA desktop as your main testing and authoring tool, then sync your important 
desktop Chart Suites and analysis to ProTA Mobile via your Apple iCloud. 


To preserve bandwidth and memory usage, you will choose the specific Chart Suites and 
the specific tickers to be copied from ProTA desktop to your ProTA Mobile apps.


Step 1 - Chart Suite Selection (ProTA macOS) 

•	 Choose Open Chart Suite (command-O) from the File menu. 





•	 Select any row or rows and then choose Toggle ProTA Mobile Sync from the popup 
gear widget menu at the bottom. Charts Suites that will sync to iCloud are indicated 
with a cloud/up arrow icon on each row.


Tip.  This step is only required the first time you specify which Chart Suites to sync.  The 
iCloud icon will persist on each row unless you disable it by again choosing the Toggle 
ProTA Mobile Sync command.


3



Step 2 - Ticker Selection and Uploading (ProTA macOS) 

•	 Choose ProTA Mobile Sync from the Tools menu.




•	 Click the Tickers button to select which tickers (up to 100) to include in the sync.


•	 Click the Upload Now button to begin the upload.  Progress and success is reported 
in the window.


Step 3 - ProTA Mobile App:  iCloud Sync 

•	 In your ProTA Mobile app, tap the gear widget to see the Settings Screen then tap 
the iCloud Sync tab


	 


•	 Tap Sync Now to download your files from iCloud to your device.  Re-launch ProTA 
Mobile to work with your synced files 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 Auto Linear Regression Trendlines - page 94	  
Auto Linear Regression Trendlines is a price-based indicator that analyzes the most 
recent price data to compute a line-of-best-fit (Regression Line) along with a pair of 
fitting support and resistance lines. 


The Regression Line is computed using least-squares statistical analysis over the 
Lookback Period to generate a statistical line-of-best-fit based on Closes.  


The Support and Resistance Lines share the same slope as the Regression Line.  The 
Support Line is shifted downward from the Regression Line such that no Low price 
crosses through the support.  Similarly, the Resistance Line is shifted upward from the 
Regression Line such that no High price crosses through the resistance.


The Exclusion Period is the number of the most recent bars to be ignored when placing 
the Support and Resistance Lines.  If the Exclusion Period is zero, the lines will be drawn 
such that they do not cross through any of the LookBack Period Bars.  If the Exclusion 
Period is 10, for example, the final 10 Bars are not analyzed when computing the 
Support and Resistance Lines.  This allows any of the 10 most recent Bars to break the 
line, revealing a breakout or breakdown.





Lookback Period.  Enter the period of review for the line-of-best-fit, least squares 
Regression Line.  The most recent ‘Lookback Period’ Closes will be analyzed.


Exclusion Period.  Enter the period to be excluded in the review for the Support and 
Resistance Lines.  The most recent ‘Exclusion Period’ Bars will not be analyzed when 
determining the placement of both lines.


Support/Regression/Resistance Lines.  Optionally specify custom Line Style options.


Range Fill.  Shades/colors the vertical area between the Support and Resistance Lines.
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 Auto Rangelines - page 95	  
Auto Rangelines is a price-based indicator that analyzes the most recent Highs and 
Lows to compute a pair of fitting support and resistance lines along with several 
potential retracement levels. 


The Auto Rangelines Support Line is computed by locating the lowest Low during the 
specified Lookback Period.  All Lows in the Lookback Period are examined, other than 
the most recent Bars defined by the Exclusion Period.   If the Exclusion Period is zero, 
the support line will be drawn such that it does not cross through any of the Bars.  If the 
Exclusion Period is 10, for example, the final 10 Bars are not analyzed when determining 
the support Low.  This allows any of the 10 most recent Bars to break the Support Line, 
revealing a breakdown. 


The Resistance Line is computed in the exact opposite manner, identifying the highest 
High of the Lookback Period, while ignoring the most recent Exclusion Period Bars.


Up to 3 retracement levels can be highlighted based upon the support low and 
resistance high that is identified:


Mid Line will render as a 50% retracement level.


Resistance Lines will render two lines a given percentage from the range high and low.  
Common values are included in the popup gear menu such as 23.6% and 38.2% 
Fibonacci as well as 25% Quartiles.





Lookback Period.  Enter the period of review for the support and resistance levels.  The 
most recent ‘Lookback Period’ Bars will be analyzed.


Exclusion Period.  Enter the period to be excluded in the review for the support and 
resistance levels.  The most recent ‘Exclusion Period’ Bars will not be analyzed.


Support/Resist/Mid/Retracement Lines.  Optionally specify custom Line Style options.


Range Fill.  Shades/colors the vertical area between the Rangelines.
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 New Candlestick Plots - page 104	  
Heikin-Ashi. An alternate plot style, Heikin-Ashi translates to “average bar” in Japanese.  
Instead of using the raw Open, High, Low, Close values to construct each candle, 
Heikin-Ashi uses the following translations:


Close = (O + H + L + C) /  4  	 	 	 	 The average price of the bar


Open = (Previous Open + Previous Close) / 2	 The midpoint of previous bar


High = Max(High, Open, Close)	 	 	 Similar/same as normal High


Low = Min(High, Open, Close)		 	 	 Similar/same as normal Low


Compared to normal Candlesticks, Heikin-Ashi produces a smoother view of the trends. 
There is a tendency with Heikin-Ashi for the candles to stay red during a downtrend and 
green during an uptrend.


Closes-Based Color.  Instead of traditional Japanese Candlestick coloring, this option 
colors the candle body similarly to Western Bar charting, determining Up vs. Down color 
based on the change in Closing price from one date to the next.


 ProTAscript Pragmas - page 189	  
!Line1 - !Line5 

!Line specifies the default color and line style to be used when plotting the specified 
output line (a custom indicator can output up to 5 lines).  


The format of the !Line pragma is as follows:


!Line1(HexColor* for Black Charts / HexColor* for White Charts, Line Thickness, 
DropLine Thickness, Markers Type) 

If only one HexColor* (defined below) is specified, it will be used for both Black and 
White background charts.  The final 3 parameters are optional and default to a Normal 
line thickness, no droplines, and no markers.	 


Line Thickness can be a value of 0 for None and 1, 2, or 3 for various line thicknesses. 
The default is 1, a normal line thickness, if not specified.
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DropLine Thickness can be a value of 0 for None and 1, 2, 3, or 4 for various dropline 
thicknesses. The default is 0, no droplines.


Markers Type can be a value of 0 for None and 1, 2, 3, or 4 for various marker types. 
The default is 0, no markers.


Examples:


!Line1(000088)	 

Renders a normal line in medium blue on both white and black charts.


!Line1(880000/FF0000, 3)	 

Renders a medium red line on black charts or a bright red line on white charts, in a Fat 
thickness.


!Line2(888888, 0, 2)	 

When plotting the second #outputline, renders no line plot, but renders medium gray 
Heavy droplines on both black and white charts.


!RangeFill 

!Rangefill specifies the default colors to be used as shading in between the final two 
output lines of the custom indicator.  


The format of the !RangeFill pragma is as follows:


!RangeFill(HexColor* for Black Charts when final output line is BELOW previous 
output line / HexColor* for White Charts when final output line is BELOW previous 
output line, HexColor* for Black Charts when final output line is ABOVE previous 
output line / HexColor* for White Charts when final output line is ABOVE previous 
output line) 

If only one HexColor* (defined below) is specified, it will be used for both Black and 
White background charts. The ABOVE colors are optional and if omitted, the BELOW 
colors will be used for all range fill shading.


Examples:


#output1:= MA(21);

#output2:= MA(200);


!RangeFill(0C1A0C/F0FFF0, 1A0C0C/FFF0F0)	 

When MA(200) is below MA(21), green shading will render between the two lines. When 
MA(200) is above MA(21), red shading will render between the two lines.
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*HexColors.  In digital specifications such as HTML and the macOS Color Picker, colors 
are often represented as Hexadecimal RGB (Red-Green-Blue) values.  HexColors are 
always 6 characters, the first 2 representing the Red intensity, the middle 2 representing 
the Green intensity and the final 2 representing the Blue intensity.  Each R-G-B value is a 
range of 0 - 255, or in Hex, 00 - FF.  Some example colors:

	 

	 FF0000	 	 Pure bright Red

	 00FF00	 	 Pure bright Green

	 0000FF	 	 Pure bright Blue

	 FFFFFF	 	 Pure White

	 000000	 	 Pure Black

	 888888	 	 Mid Gray


	 


 ProTAscript Functions - pages 198-216	  
BarNum () 

Returns the current count of Bars (dates, data points, time periods) since the beginning 
of all data.  The first bar at the beginning of a chart will return a value of 1.  The final bar 
in a chart will return the same value as NumBars().


•	 BarNum() = NumBars() - 1 

	 will return TRUE on the second-to-last date in the chart.


NumBars () 

Returns the total count of all Bars (dates, data points, time periods) for the entire data 
set.  This function is often used with the BarNum() function.


•	 BarNum() >= NumBars() - 5 

	 will return TRUE on the final 5 dates in the chart.


Correlation (Array1, Array2, Period) 

Correlation measures the degree to which two securities move in relation to each other.  
A value of 1.0 indicates perfect 1:1 correlation between two arrays while a value of -1.0 
indicates perfectly opposite movement.  Values near zero indicate no correlation.
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Correlation r, is computed as:





•	 Correl(Close, XREF(“^DJI”, I), 100) analyzes the past 100 closes to compute the 
Correlation between this security and the Dow Jones Industrial Average (assuming 
you are tracking ticker ^DJI in your TickerPicker).


Median (Array, Period) 

Returns the Median of all Array values over the preceding Periods (including today). 


The Median is the ‘middle’ value when all values are sorted.


•	 Median(Close, 20) returns the Median Close price over the past 20 dates. 


 Dark Mode Support - page 230	 
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Set Chart Backgrounds to Match OS Light/Dark Appearance.  Under macOS 10.14 
(Mojave) or higher, the user can specify an overall appearance of Light or Dark (Dark 
Mode) in the macOS System Preferences app.  


When this box is enabled in ProTA, chart background colors will automatically be set to 
either Black or White to match the macOS appearance setting.


Note.  When Set Chart Backgrounds to Match OS Light/Dark Appearance is 
enabled, the user is prevented from manually editing any chart Background colors.


Thank you!

Thank you for using ProTA!   

Jeff
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